NVivo: 11Pro – Next Steps
Qualitative Data Analysis

Course objectives:
Making content into data
- Import media content
- Create a codebook
- Sets and Classifications
- Further exploration of data
- Visualisation tools

Student Training and Support
Phone: (07) 334 64312
Email: askus@library.uq.edu.au
Web: https://web.library.uq.edu.au/library-services/training/

Service Points
St Lucia: Main desk of the SSAH, ARMUS and DHESL libraries
Hospitals: Main desk of the PACE, Herston and Mater libraries
Gatton: Level 2, UQ Gatton Library

Staff Training (Bookings)
Phone: (07) 3365 2666
Email: staffdev@uq.edu.au
Web: http://www.uq.edu.au/staffdevelopment

Staff may contact their trainer with enquiries and feedback related to training content. Please contact Staff Development for booking enquiries or your local I.T. support for general technical enquiries.

Reproduced or adapted from original content provided under Creative Commons license by The University of Queensland Library
# Table of Contents

**NVIVO: 11Pro** ................................................................................................................................. 3
  - Exercise 1. Access NVIVO .................................................................................................................. 3

**Getting Started** .............................................................................................................................. 3
  - Exercise 2. Open a project .................................................................................................................. 3

**Working with Data** ........................................................................................................................... 3
  - Exercise 3. Import Content ............................................................................................................... 3
  - Exercise 4. Coding Sources .............................................................................................................. 6
  - Exercise 5. View Image Coding ....................................................................................................... 7
  - Exercise 6. Create a new node .......................................................................................................... 8
  - Exercise 7. Create a Codebook ...................................................................................................... 8
  - Exercise 8. Import a Codebook ....................................................................................................... 9

**NCapture for web sources.** ............................................................................................................. 9
  - Exercise 9. Import content with NCapture .................................................................................. 9
  - Exercise 10. Explore Imported Social Media Content ............................................................... 12
  - Exercise 11. AutoCode NCapture import ................................................................................. 14
  - Exercise 12. Explore Twitter Data ................................................................................................ 15
  - Exercise 13. View Classification Sheets .................................................................................... 15

**Sets** ............................................................................................................................................... 16
  - Exercise 14. Create Sets for Analysis ............................................................................................ 16
  - Exercise 15. Create a Matrix Coding Query using Sets ............................................................. 17

**Classifications** ............................................................................................................................... 18
  - Exercise 16. Import a classification sheet ................................................................................... 19

**Querying Data** .................................................................................................................................. 21
  - Exercise 17. Create a Matrix Coding Query using Classifications ............................................. 21
  - Exercise 18. Create a Coding Query ............................................................................................ 22

**Visualisation Tools** ......................................................................................................................... 24
  - Exercise 19. Code Charting .......................................................................................................... 24

**Exporting NVivo Data** ...................................................................................................................... 26
  - Exercise 20. Export Node References .......................................................................................... 26
  - Exercise 21. Export a Node Summary .......................................................................................... 26
  - Exercise 22. Export a Node Matrix .............................................................................................. 27

**Reports and Extracts** ....................................................................................................................... 27
  - Exercise 23. Create a predefined report ...................................................................................... 27
  - Exercise 24. Create a predefined extract ..................................................................................... 28

**Extension Exercises** ....................................................................................................................... 30
  - Exercise 25. Add ‘case’ classifications ......................................................................................... 30
  - Exercise 26. Add ‘source’ classifications ...................................................................................... 31
  - Exercise 27. View Classification Sheet ......................................................................................... 32

---

Exercise files: Go to [https://web.library.uq.edu.au/library-services/training/training-resources](https://web.library.uq.edu.au/library-services/training/training-resources)
**NVIVO: 11Pro**

NVIVO is designed to facilitate common qualitative techniques for organising, analysing and sharing data in a research project. NVivo can help you manage, explore and discover patterns in your data but it cannot replace your analytical expertise.

---

**Exercise 1. Access NVIVO**

1. Double-click the **Nvivo 11** icon on the Desktop

2. Complete profile details, if prompted

3. Add your initials.

These will be used to identify your edits as you progress

4. Click on **OK**

---

**Getting Started**

**Exercise 2. Open a project**

A standalone project is a **.nvp** file saved on your computer or on a network drive.

1. Click the **File** tab

2. Click **Open**.

**Note:** Ensure **NVivo Projects** from the **File** or **Project type** list is displayed

3. Locate and select **UQLTraining-NextSteps** project

4. Click **Open**

---

**Working with Data**

**Exercise 3. Import Content**

a. **Bring in a PDF**

1. Select **Internals**

2. Click the **Data** tab

3. Click the **PDF** button
4. Navigate to the **Other Data** folder
5. Double click **Sea Grant Fact Sheet.pdf**
6. Click on **OK**

7. Click on **OK** in the Document Properties window, if required

The PDF is added to the list of sources

### b. Bring in images

1. Select **Internals**
2. Click the **Data** tab
3. Click the **Pictures** button
4. Navigate to the **Other Data** folder
5. Select **Barrier Islands and Cape Lookout**
6. Click on **Open**
7. Click on **OK**

8. Click on **OK** in the Document Properties window, if required

The image is added to the list of sources

### c. Bring in Audio

A video or audio source consists of a media file and a transcript. The transcript can be manually added, automatically created or purchased via NVivo and Transcribe.

1. Select the destination folder in Internals (**interviews**)  
2. Click **Audios** on the data tab
3. Navigate to the audio file **Helen** in Media Data
4. Click on **open**
5. Click on OK

6. Go to the Audio tab
   Ensure Embedded in project is selected. This should be the default setting

7. Click on OK

The audio file will be added to the list of internal interview sources

Transcribe audio for coding

1. Double click the file to open in details view
2. Click on Click to edit
   This will open the audio log for transcription

3. Use the playback tools on the media tab
4. Click to enter timespan
5. Add 0-10
6. Click next cell to enter transcript
7. Add “Interviewer Question”

Purchase a transcript from NVivo (QSR International)

You can also purchase a transcript from NVivo. As at Aug 2017 the cost per minute is $2.25 USD and the turnaround is between 24 – 72 hours depending on requirements.

1. Go to the Data tab
2. Click Purchase Transcript

3. Setup a TranscribeMe! Account
   This will allow NVivo to access your account and upload your transcripts directly when they are completed
4. Select the appropriate settings for your audio transcript

**Import Transcript for coding**

1. Click **Documents** on the DATA tab
2. Select **Helen Transcript** in the Media Data folder
3. Click on **Open**
4. Click on **Ok**

**Exercise 4. Coding Sources**

a. **Code documents**
   1. Go to **Sources**
   2. Open Helen’s transcript
   3. Select “she doesn’t want to sacrifice the environment to gain affordable housing”
   4. Right click on selected text
   5. Select **Code...**
   6. Hold Ctrl to select nodes
      - Community Culture
      - Realestate Development
      - Natural Environment
   7. Click on **OK**
      Check the Node hierarchy, coding has been added to the appropriate nodes
   8. Repeat for other transcript paragraphs
b. **Code PDFs**

Be careful with PDF’s. If the file has been created as an image coding specific content will not be possible.

1. Goto **Sources**
2. Open the PDF
3. Highlight a paragraph

4. Navigate to **Nodes** to display Hierarchy
5. Drag and drop paragraph over **water quality** node

---

c. **Code Images**

1. Go to **Sources**
2. Open the image
3. Click and drag across a part of the image

4. Navigate to **Nodes** to display Hierarchy
5. Drag and drop selection over **Natural Environment** node

---

**Exercise 5.**

1. Go to **Nodes**
2. Double Click to open **Natural Environment**
3. Click link to image **Barrier Island and Cape Lookout**

   The image coding reference will be pixel co-ordinates: starts at 330x270y and ends at 620x480y

4. The coded section will appear as inverted/shaded

---
Exercise 6. **Create a new node**

1. Navigate to **Nodes**
2. Select **Node** on the **Create** tab

3. Enter a name - **Social Media**
4. Add a description – **NCapture Data**
5. Click on **OK**

The new node will be displayed in your node hierarchy.

**Codebook**

A codebook is a list of your thematic nodes and their descriptions that you can export from NVivo. You (or members in your team) can refer to the codebook to ensure consistency of coding.

Exercise 7. **Create a Codebook**

Ensure your nodes have a description before generating a codebook.

a. **Add Node Description**

   1. Click **Properties** on the **Home** tab
   2. Select **Node properties**...

   3. Enter a description
   4. Click on **OK**

b. **Generate Codebook**

   1. Click **Codebook** On the **Data** tab

   The Export Codebook dialog box displays.
2. Confirm a location for your codebook
   By default, the Automatically select subfolders check box is selected, so any subfolders will be included if you select or deselect a parent folder.

3. (Optional) Select Include number of sources and references check box.

4. Click OK.
   Your codebook will display as an external document. Save the file to keep a permanent copy.

### Exercise 8

**Import a Codebook**

To provide easy reference to the codebook for all researchers, it can be imported back into your project.

1. Click Documents on the Data tab
2. Select the Codebook document
3. Click on Open
4. Click on OK
5. (Optional) Add a description in document properties
6. Click on OK

---

**NCapture for web sources.**

NCapture is a tool which allows users to capture web content including web pages, social media and video/audio clips

### Exercise 9

**Import content with NCapture**

To use the NCapture tool you have to first of all add the extension to your browser.

a. **Install NCapture extension to browser (Google chrome)**

1. Search in the browser "NCapture Google Chrome"
2. Click the link to the Google Web Store
Check the extension available is **offered by QSR International**

3. Click “**+ ADD TO CHROME**”

4. Click **Add extension**
A confirmation pop up may display. You can now capture web content for your NVivo project.

b. **Capture web content**

1. Navigate to a web source: [http://abc.net.au](http://abc.net.au)
2. Open any article
3. Click the NCapture icon on the addressline

4. Select **Source type: Article as PDF**
This may not be successful with sites that contain dynamic data which automatically updates. You may need to use **WebPage as PDF** but be aware this will include all content including ads.

5. **OPTIONAL:** Add a description

6. **OPTIONAL:** Code at Node – **Social Media**
   *Add Node names for auto coding (New or existing)*

7. Click on **Capture**
The article will be converted to a .nvcx file and the NCapture progress page will be displayed

c. **Capture Media Clip Content**

1. Navigate to youtube: [http://youtube.com](http://youtube.com)
2. Go to an appropriate media clip
   [https://www.youtube.com/watch?v=DqDaZNyUKOg](https://www.youtube.com/watch?v=DqDaZNyUKOg)

3. Click the NCapture icon on the addressline
4. Select Source type: **Video and Comments**
5. **OPTIONAL:** Add a description
6. **OPTIONAL:** Code at Node – **Social Media**
   *Add Node names for auto coding (New or existing)*
7. Click on **Capture**

Confirmation of the capture will be displayed

d. **Capture social media content**

1. Navigate to a twitter feed: **twitter.com/UQ_News**
2. Click the **NCapture** icon on the addressline

3. Select Source type: **Tweets are organised into a Dataset including Retweets**
4. **OPTIONAL:** Add a description
5. **OPTIONAL:** Code at Node – **Social Media**
   *Add Node names for auto coding (New or existing)*
6. Click on **Capture**

You may be asked to authorise NCapture to use your twitter account
7. Click on **Authorize app** or Log in
   You’ll be returned to the twitter page.
8. Click on **Capture**
   This can capture up to 5000 tweets

The article will be converted to a .nvcx file
e. **Import NCapture content**

1. Open NVivo project
2. Navigate to **Internals in Sources**
3. Click **From Other Sources** on the **DATA** tab
4. Select **From NCapture**

5. **Browse** to locate captures folders, if necessary
   Captures are usually located in the **Downloads** folder depending on the browser used.
6. Click **Selected Captures**
7. Select the captures to be imported

8. (Optional) Select Merging matching social media datasets
   This is the best way to bring in data captured over time
9. Click on the **Import** button

10. Navigate to **Internals in Sources**
    The imported content will be available.

**Exercise 10. Explore Imported Social Media Content**

a. **Display chart of social media content**

1. Navigate to **Sources**
2. Go to **UQ News Twitter**

3. Click the **Chart** tab at the right

4. Click **Select Data** on the **Chart** tab in the ribbon
5. Select **Timeline by quarter** for the X-axis
6. Select **No of references** for the Y-axis

7. Double-click the chart series to see tweets

b. **Display cluster analysis**

1. Go to **UQ News Twitter**

2. Click the **Cluster Analysis** tab at the right
   A horizontal dendogram will display

3. Change to a 2D or 3D cluster on the ribbon
4. Double-click on any entry to view details

c. **Display map**

1. Go to **UQ News Twitter**

2. Click the **Map** tab at the right
3. Double click a pin to see tweets

4. Right-click on map

5. Select Export Map...

Exercise 11. **AutoCode NCapture import**

1. Select the Twitter source
2. Click AutoCode on the ANALYZE tab

3. Confirm Code for nodes at each value in predefined twitter columns
4. Click on Next

5. Select the Username and Hashtag options, if necessary
6. Click on Next

7. Enter a name for the Nodes – **Twitter Hashtags**
8. Enter a name for the Cases – **Twitter Handles**
9. Click on Finish

This make take a little while depending on how many tweets you have to deal with.
Exercise 12.  

**Explore Twitter Data**

a. **Nodes**

1. Navigate to **Nodes**
2. Expand **Twitter Hashtags**
3. Expand **Hashtags**
4. Sort by **references**
5. Double-click any **hashtag**
6. Click **node** link
7. Click **Dataset** tab at the right

**Nodes**

- [Image of Nodes]

b. **Cases**

1. Navigate to **Cases**
2. Expand **Twitter Handles**
3. Expand **Usernames**

**Nodes**

- [Image of Cases]

---

Exercise 13.  

**View Classification Sheets**

View the classifications automatically applied to imported twitter NCapture

1. Go to **Classifications**
2. Select **Case Classifications**
3. Expand **Twitter User**
   The attributes for each user/case are displayed

4. Click on **Case Classification Sheets** on **EXPLORE** tab
5. Select **Twitter User**

---

---
**Sets**

Sets are a flexible way of grouping your sources and nodes. Items in a set are references or 'shortcuts' to the original files. You can delete an item from a set without removing it from your project.

### Exercise 14. **Create Sets for Analysis**

**a. Create Set**

1. Navigate to **Collections**
2. Right-click on **Sets** folder
3. Select **New Set**

4. Add **Female respondents**
5. Click on **OK**
6. *Repeat for Male respondents*

**b. Add members**

1. Right-click on set **Female Respondents**
2. Select **Add Set members...**

3. Go to **Cases**
4. Select all **Female** cases
5. *Repeat for Male Respondents*

All selected cases will be added to the appropriate set
Exercise 15. Create a Matrix Coding Query using Sets

Matrix coding query can easily compare coded material across different demographics or among themes. This can help you see patterns in your data and help you answer questions about your research. We can look at the intersect between sets and nodes.

a. Create a New Matrix from Sets

What we want to know is... What do interviewed males and females say about the Natural Environment?

1. Click Matrix Coding on the query tab
   The New Matrix dialog box opens

2. Click the checkbox Add to Project

3. Enter a name Set Matrix

4. OPTIONAL enter a description

5. Click on the Matrix Coding Criteria tab

6. Click the Select... button on the Rows tab

7. Select Sets

8. Select Male Respondents and Female Respondents

9. Click on OK

10. Click on the Add to list button

11. Click the Column tab

12. Click the Select... button

13. Select the nodes for the Natural Environment to cross tabulate in the matrix.
   Theme nodes represent coded text in the content

14. Click on OK

15. Click on the Add to list button
16. Go to **Query Options** tab  
17. Click Option field  
18. Select **Create Results as New Node Matrix**  
19. Change **Location** to **Results**  
20. Add Name **Interview Sets**  
21. Click on **Run**  
   If you click OK you don’t actually query the data. The query will be added to the queries folder. Navigate to the **Set Matrix** query and double-click to run

22. You can run the query anytime from **Queries** in the Navigation view pane.

23. Double click **set matrix** result number to see content

### b. Viewing and amending matrix results

1. Click **Node Matrices** on the **View** tab  
2. Select **Words Coded**
   
   The number of words coded by each gender for each question will be displayed.

3. Double click on any number result to see the coded references

### Classifications

Coding allows you to organize your sources for later data analysis. Classifications are necessary to allow for further querying of data. They store information about your participants and sources. They provide a way to record descriptive information about the sources, nodes and relationships in your project. Think of this as a way of creating a database of imported content to help analyse it further. You can only have one classification applied to a node or source at any time.

These generally fall into 3 levels:  

- **The Classification**
- **The Attributes** within the classification
- **The Values** included in each attribute

Assigning cases and sources to classifications will allow you probe your data in a bit more depth.
Exercise 16. **Import a classification sheet**

NVivo associates your interview data with your attribute or demographic data through a case classification

**a. Import Spreadsheet of demographic data**

1. Navigate to **Classifications**
2. Go to **Cases classifications**
3. Right click in **List View**
4. Select **Import Classification Sheets...**
5. Click on **Browse...**
6. Select **Interview Participants_Classification Sheet.xlsx** in the **Other Data** folder
7. Click on **Next**

The key thing to this process is that NVivo will automatically recognize that you have a case node and associate all relevant information with the case provided that the name of the case node is exactly the same as the first cell in the spreadsheet.

Confirm this will be a case classification

8. Select the options:
   a. **Create new attributes**
   b. **Update the classification of existing sources or cases**
   c. **Replace attribute values of existing sources or cases**
9. Click on **Next**

Confirm the location of your cases

10. Select **As Names**
11. Click on **Select...**
12. Select **Cases\interviewees**
13. Select **Create new cases if they do not exist**
14. Click on **Next**

15. Confirm the **Date, Time and Numbers** formats
16. Click on **Finish**

The classification sheet will display
b. **Apply cases to classification**

1. Navigate to **Nodes**
2. Go to **Cases in Nodes**
3. Select all **interviewees** cases
4. Right click on selection
5. Hover over Classification
6. Select classification: **person**

   The data will be classified with attributes but will have no assigned values yet.

---

C. **Add/Edit attribute values**

1. Navigate to **Classifications**
2. Right-click **Age Range** in the **Person** classification
3. Select **Attribute Properties…**

   ![Classification Image](image_url)

4. Click the **Values** tab
5. Click the **Add** button
6. Enter **30-39**
7. Click the **Add** button
8. Enter **50-59**
9. Click the **Sort** button

10. Click the left side of the **not available** option
11. Click the **Remove** button

   ![Attribute Properties Image](image_url)

   If the removed attribute value is in use you will be prompted to select an alternative

---

---
d. **Assign values to classification entries**

1. Assign a gender to each interviewee
2. Assign an age group to each interviewee

---

**Querying Data**

**Exercise 17. Create a Matrix Coding Query using Classifications**

**a. Create a New Matrix from Classifications**

What we want to know is... **How do different age groups responses compare?**

1. Click **Matrix Coding** on the query tab
   The New Matrix dialog box opens

2. Click the checkbox **Add to Project**

3. Enter a name **Class Matrix**

4. OPTIONAL enter a description

5. Click on the **Matrix Coding Criteria** tab

6. Click the **Select...** button on the **Rows** tab

7. Select **Case Classifications**

8. Select **Age Ranges**

9. Click on OK

10. Click on the **Add to list** button

11. Click the **Column** tab

12. Click the **Select...** button

13. Select all nodes except survey data to cross tabulate in the matrix.

14. Click on OK

15. Click on the **Add to list** button
16. Go to Query Options tab
17. Click Option field
18. Select Create Results as New Node Matrix
19. Change Location to Results
20. Add Name Age Classification
21. Click on Run

If you click OK you don’t actually query the data. The query will be added to the Queries folder. Navigate to the Class Matrix query and double-click to run

Results will be displayed

b. Viewing and amending matrix results

1. Right-click the matrix
2. Select Transpose
3. Double click on any result number to see the associated coded references

Exercise 18. Create a Coding Query

What we want to display is...All the interviews which women mention the Economy

1. Click Coding on the Query tab
2. Confirm Settings:
   ANY of the following are true
   Coded at Any Selected Node
3. Click the Ellipses button
4. Select Economy and its child nodes
5. Click on OK
6. Click the + symbol
7. Select Any Case Where
8. Click the ellipsis button

9. Expand Person
10. Select Gender

11. Set the Gender value Equal to Female

12. Click Run Query
   Results may be displayed

13. Click Save Results... to keep a copy of results in the project

If no results appear it might mean no coding exists at that point in time. A message displays indicating there are no results. Change query settings or add coding before running query again.

14. Click Add to project... to save the query settings
**Visualisation Tools**

**Exercise 19. Code Charting**

a. **Create a chart from node content**

1. Click on any node

2. Select Chart on the Explore tab

3. Select Chart Node Coding

A chart will display reflecting a descending amount of coding for node content

b. **Create a coding chart from multiple nodes by attribute values**

What we want to chart is... *coding references in the interview questions by age group*

1. Select the 6 interview question nodes

2. Click Chart on the Explore tab

3. Select Chart Nodes Coding by Attribute Value

4. Expand Person

5. Select Age Range

6. Click on OK

7. Adjust x and Y axis settings
   a. X-axis: All attribute values except “Unassigned”, “Not Applicable”
   b. Y-axis: Number of coding references
8. Click on OK
A chart will display showing the coding criteria requested. Use the chart tab on the Ribbon to change chart settings

c. Hierarchy Chart
A Hierarchy chart lets you visualise the coding associated with either nodes or sources or the values assigned to either cases or sources.

1. Navigate to Nodes
2. Go to Interview Questions folder
3. Select all question nodes

4. Click Hierarchy Chart on the Explore tab
5. Select Hierarchy Chart of Nodes

A hierarchy chart of coding is displayed
Exporting NVivo Data

Exercise 20. Export Node References

Node References will export to a Word document as a default

1. Select the node to export in List View (Natural Environment)
2. Click Items on the Data tab

3. Select Reference View
4. (Optional) select the Browse button to change the name, location or format of the exported file
5. (Optional) Select the properties and related content that you want to include in the exported file.
6. (Optional) Select the Open on Export check box

The exported references will open

Exercise 21. Export a Node Summary

A Node summary will export to an Excel spreadsheet as a default

1. Select the node to export in List View (Natural Environment)
   If you export a parent node with node aggregation turned on, the exported node includes content coded at the parent and content coded at all of the child nodes.
2. Click Items on the Data tab

3. Select Summary View
4. (Optional) select the Browse button to change the name, location or format of the exported file
5. (Optional) Select the Open on Export check box

The exported summary will open
Exercise 22.  

**Export a Node Matrix**

A Node Matrix query will export results to an Excel spreadsheet as a default.

1. Navigate to Queries
2. Double click **Class Matrix** to run
3. Right click anywhere in the matrix
4. Select **Export Node Matrix**

5. Click on **Save**
The matrix will be available as a spreadsheet.

**Reports and Extracts**

Reports contain information about your project that you can view and print. An extract allows you to export a collection of data for complementary analysis in other applications.

Exercise 23.  

**Create a predefined report**

a. **Create a report**

1. Navigate to **Reports**
2. Select the **Reports** folder
3. Double click **Coding Summary by Node Report**

4. (Optional) Click a check box if you want to filter results
   a. Click **Select** to define filter criteria
5. Click on **OK**

The report is created and displayed in Details View. This includes a Report Map and thumbnails. Reports are dynamic and generated when run. To retain this information as a snapshot of progress you can export the results or create an extract.
b. **Export a report**

1. Right click on the report
2. Select **Export Report Results**

3. Navigate to a location for the extract to be saved
4. Click on **Save**

The report is available as a Word document.

---

**Exercise 24. Create a predefined extract**

a. **Create an extract**

1. Navigate to **Extracts**
2. Select the **Extracts** folder
3. Double click **Coding Summary by Node Extract**

4. (Optional) Click a check box if you want to filter results
   a. Click **Select** to define filter criteria
5. Click on **OK**
6. Navigate to a location for the extract to be saved
7. Change the file type to **MS Excel (*.xlsx)**
8. Click on **Save**

9. A success message will display on completion.

b. **Open the extract in Excel**

You may need to tidy up the extract before further analysis in Excel. All numbers brought across will be interpreted as text. This needs to be converted into numbers for reliable calculation

1. Navigate to **Coding Summary by Node Extract.xlsx**
2. Open the spreadsheet

3. Select a single column – J
4. Click **Text to Columns** on the **Data** tab

As only the cell content needs converted we do not need any other steps
5. Click on the **Finish** button

Ensure the column is still selected
6. Click the **percentage** button on the **home** tab
Extension Exercises

Further Classifications

If you do not have a spreadsheet of demographic information you are able to create your own classification sheets and apply appropriate content to each case or source classification.

Exercise 25.  Add ‘case’ classifications

a. Create a CASE classification

A case can only be in one classification at a time

1. Navigate to Classifications
2. Go to Case Classifications
3. Right click in List view
4. Select New classification

5. Add a name: Residents
6. Click on OK

b. Add attributes and values

1. Click on Residents classification
2. Click on Attribute on the Create tab
3. Add an attribute name (Age group)
4. Go to the Values tab
5. Click on the Add button
6. Enter Over 50 attribute value
7. Click on the Add button
8. Repeat for Under 50
9. Click on OK

10. Repeat above to add a new attribute (Gender)
11. Add the values Male and Female
Exercise 26.  

Add ‘source’ classifications

a. Create a SOURCE classification:

A source can only be in one classification at a time

1. Navigate to Classifications in Navigation view
2. Go to Source Classifications
3. Click Source Classification on the CREATE tab
4. Select Add one or more predefined classifications to the project
5. Click the checkboxes for the classifications to add:
   - Audiovisual Material,
   - Book,
   - Electronic Article
   - Interview &
   - Webpage
6. Click on OK
   The new classification for Sources will appear.

b. View source classifications; attributes

1. Click on Source Classification Sheets on the Explore tab
2. Select Interviews
   The interviewees will be listed under this classification
3. Click on the plus symbol
   This will open the classifications to see attributes

c. Modify attributes and values

1. Navigate to Classifications
2. Select Source Classifications
3. Expand the interview classification
4. Double click on Interviewer
5. Click the **Values** tab
6. Click the **Add** button
7. Enter **Henry**
8. Repeat for **Nancy, Linda and Elizabeth**
9. Click the default checkbox alongside **Henry**
10. Click on **Apply**
11. Click on **OK**

If you choose to add values to a date and time attribute the format will be - *dd/mm/yy hrs:mins:secs.am*

d. **Apply classification to sources**

12. Navigate to **Sources**
13. Go to **interviews** in internals
14. Select all interviews
15. Right click on selected interviews
16. Hover over Classification
17. Select classification: **Interview**

**Exercise 27.**

18. Go to **Classifications** in Navigation view
19. Click on **Source Classifications**
20. Double click on **interview**

The entries will be displayed with unassigned values

e. **Assign values to classification entries**

1. Click on an unassigned field
2. Select an appropriate value

If all other entries have the same value copy and paste can be used to speed up the process.

3. Copy the first entry’s value (ctrl+C)
4. Select all other unassigned entries

Click top entry, shift and click on last entry

5. Paste value (ctrl+V)